Using the UARC HF remote station(s)

IMPORTANT CHANGES:
• The original radio – an Icom IC-718 – has been
replaced with a Kenwood TS-480. Please note
user-interface changes when operating this “new”
radio.
• Antenna port “TWO” of the radio is now connected to an end-fed
half-wave antenna that covers the lower half of 160, most of 80/75
meters, the 60 meter channels and all of 40 meters.
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The Utah Amateur Radio Club’s HF remote station near Leamington, Utah is available to all
members in good standing that hold a valid General, Advanced or Extra class amateur radio
license. If you wish to use this HF remote station send an inquiries via email to:

hfmanager@utaharc.org
If you wish to join UARC, visit the Utah Amateur Radio Club web page
(http://wwww.utaharc.org) and click on the “How to join or renew” link along the left side.
20190609-V2c-CT
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Overview of the UARC HF Remote station.
The Utah Amateur Radio operates an Internet-based remotely-controlled HF station near the
central Utah town of Leamington in the DM39 grid square. Located at this site is a computercontrolled HF transceiver that is connected to two HF antennas:
The radio:
The radio on site is a Kenwood TS-480S capable of operating from 160 through 6
meters. This is a 100 watt radio with a built-in antenna tuner capable of modest
adjustment range which means that it can tune resonant antennas somewhat beyond
the design frequency range – but it won’t be able to “force feed” antennas that are toofar beyond a 50 ohm match.
This radio also has digital noise reduction and filtering.
Antenna ONE:
This is a G5RV antenna capable of operating across much of the 80 meter band as
well as the 40, 20, 15 and 10 meter bands – and likely the 6 meter band. The highest
end of this center-fed antenna is at approximately 35 feet and it and the ground slopes
so that the far end is about 15 feet above the ground.
This antenna does NOT work on the 160 meter band and it may not work 60, 30, 17 or
12 meter bands.
Antenna TWO:
This is a transformer-fed end-fed halfwave antenna with a fundamental frequency of
approximately 1850 MHz. As such, it can be used on the bottom-half of the 160 meter
band (1800-1900 kHz), much of the 80/75 meter band, the 60 meter channels and the
40 meter band. The “feed” end of this antenna is at approximately 65 feet above
ground with most of its 260 foot length being higher than about 30 feet above ground.
The transformer’s performance is optimized for the bands 40 meters and lower in
frequency.
It is expected that this antenna will generally outperform antenna ONE (the G5RV) on
160, 80 and 40 meters. It may “tune” bands for which it is not intended to be used, but
it is not expected that it will work as well as the G5RV on the 30, 20, 17, 15, 12 and 10
meter bands.
In the sections that follow you will find information related to the installation of the program
required to remotely operate this radio, how to get permission to transmit, and details about
operating this radio.
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Section 1: Accessing this station
The Utah Amateur Radio Club (UARC) has established a
remotely-accessible HF station near the central Utah town
of Leamington, about 22 miles east of Delta. This system
allows operation on all amateur bands from 80 through 10
meters using CW and SSB. Transmission using digital
modes and/or on 160 meters is not currently available.

Important:

This manual is targeted for
use by someone who already
has
some
experience
operating on the HF amateur
bands: It is not intended to
be used as a “how to”
This station allows HF operation by those who may not manual for operating on the
have their own station or are in an area where – due to HF bands for the first time.
local restrictions or high noise levels – may only be able to
set up a “sub optimal” HF station.
If you are new to HF
operation and need help,
contact the HF manager.
How to get access to this station:
Note: Anyone may use the remote if they are just listening. It is only the ability to
transmit that is limited to club members with the appropriate license.
If you wish to obtain transmit access to this station, there are a few prerequisites:
•
•
•
•
•
•

You must be a member of the Utah Amateur Radio club in good standing or receive
“special dispensation” on a case-by-case basis by the UARC president.
Review Section 10 of this document. Contact information may be found there.
If you wish to transmit from this station, you must have a current General Class or
higher amateur radio license. (You do not need a license to listen.)
You must contact the president of the Utah Amateur Radio Club and request access to
the station.
You must read and agree with the “Guidelines for use of the UARC Remote HF
Radio Station” document.
If you have other questions, feel free to contact the HF station manager at:
hfmanager@utaharc.org

“OK, I have been given access – now what?”
There are two ways to access the HF station:
•
•

With the free RCForb Windows program. (Sorry – no Linux or Apple versions yet…)
With the RCForb Android app which may be obtained for $10 from the “Play Store”.
(Sorry, no IOS version yet…)
We recommend that you use and get familiar with the Windows program
– which is free – before spending $10 (non-refundable!) for the Android
app.
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Section 2: Getting and installing remote software
Getting the program:
The RCForb Windows client software may be downloaded from this site:
http://download.remotehams.com/
A useful installation document may be found on the following web page. Please download
and read it:
http://www.remotehams.com/help.html - Download both the “Getting Started Guide” and the
“RCForb Client Manual”.
IMPORTANT: On the download page you will find several versions of the RCForb client:
•
•

It is strongly recommended that you use the newest version of RCForb 0.8:
There is an “RCForb 0.9”, but it is reported to have a few bugs in some versions
of Windows.
Once you are familiar with version 0.8, you can see if 0.9 will work on your
computer.

Important: You should download the Client software, not the Server software.
Prerequisites for the RCForb program:
•

Before you can transmit, you must sign up for an account on the web site. This step is
necessary to verify that you are, in fact, a licensed radio amateur in your country.
◦ Click on “Sign Up” in the upper-left corner of the download page and you will be
guided through the process. You must supply a valid email to do this.
◦ To use the UARC remote your username MUST include your callsign. This
allows us to easily determine who is using the remote. If you already have a
username without an embedded callsign and don’t wish to change it, please
contact the UARC president.

•

The computer must run Windows. Version 0.8 will “officially” support XP, Windows
Vista, Windows 7 and Windows 8 – and it seems to work fine with Windows 10. (See
the RCForb download page for more details on supported operating systems.)

•

If you want to transmit, you must be able to connect an external microphone. An
inexpensive headset with a built-in boom microphone is preferred.
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◦ DO NOT use the microphone built into your computer or laptop as these are
not only noisy, but they will be far away from your mouth and pick up every sound
and echo in your room: If you insist on using such a microphone, you will
always get lousy audio reports and people will have difficulty understanding
you!
◦ Many laptops do not have a separate microphone input. In some cases these
computers can use a special headset (see the manual) but there may be other
options:
▪ Your computer must have a sound card with a microphone input. Be aware
that many laptops may lack a microphone input or require a special cable.
• The use of an external USB sound card with separate speaker/headphone
and microphone jacks and can be pretty inexpensive.
▪ If you computer has Bluetooth, an inexpensive headset may work fine.
◦ When running the Android app on a smart phone, users have had good luck using
the internal microphone or bluetooth headsets as long as their microphone gain
has been set correctly. Using such a device in “hands free” mode usually results
in rather poor transmit audio and is not recommended.
•

It is strongly recommended that you use a headphone. These not only help with
intelligibility in noisy band conditions, but keeping the receiver noise to yourself will
prevent you from becoming unpopular with your spouse and/or kids!

•

A “decent” Internet connection. 1.5 megabits/second or higher is OK – but the more,
the better, particularly if someone else is using your Internet connection to watch
TV/Movies. A “solid” 4G or better cell phone connection is recommended for mobile
use.

•

A mouse, touch screen or track-pad is highly recommended.

Installation of RCForb:
This part’s simple: Simply download and install it as usual for a Windows program.
Depending on your system, it may prompt for an update/installation of other supporting
software.
For the best guide for installing RCForb please download the guides from the web site linked
below:
http://www.remotehams.com/help.html
Download both the “Getting Started Guide” and the “RCForb Client Manual”.
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Section 3: Configuring the RCForb program
Configuration of RCForb:
Log in:
After you have registered on the “remotehams.com” web site, start the RCForb program
and click on File→New Connection (upper left-hand corner.) There, you will be prompted to
enter your username and password of the account that you have set up.
Once you have logged into the network, the screen should be populated with available radios
around the world.
Recommended:
•

At the top of the screen, to the right of “File” and “Options”, you will see “ * Upload
Amateur Radio License *”. It is recommended that you upload a legible picture or
scan of your current amateur radio license and upload it via this tab. This provides a
means of aiding in the verification that you are a licensed amateur.

Important:
•

Most (if not all) transmit-capable remotes you will find via the RemoteHams software
will require that you obtain permission before you can transmit. To get transmit
permission, use the contact information found at that radio’s link in the program.
◦ It may take several days to a week or so before the operator of a particular radio
installation will get back to you regarding permission to transmit.
◦ Transmit permission for some sites may be limited to members: Some
operators of remote stations, like UARC, require membership in the supporting
organization as a “perk” and may not grant transmit privileges unless you are a
member while still others may not be interested in granting you transmit permission
at all.
◦ Rules in certain countries may not permit operation of a remote transmitter located
in that country by amateur radio operators outside that country.
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Section 4: Connecting to the remote station and its basic
operation
Connecting to a remote radio:
In the middle of the
screen there will be a
list of remote radio
sites. Above this list,
left of center will be a
box labeled “Search”
and in this box enter
“UARC” (without the
quotes, of course!) and
hit Enter. At the top of
the
screen
should
Figure 1:
appear the entry for the
Utah Amateur Radio
Club remote station as “UARC" has been entered in the "Search" box and has resulted in the HF remote
appearing at the top of the list of remotes
depicted below:

Communicating with other users of the remote:
At the bottom of the main
screen is the “chat room”
which
is
used
to
communicate with other
users of the remote.
Where it shows “type a
message” in Figure 2,
you may enter your own
Figure 2:
text (then click “send”)
which will make it visible
The "Chat Room" at the bottom of the main screen may be used to
to all others currently communicate with other users – including requests to take control of the remote.
using the remote.
By
using the “slider” to the right of the text you may see a history of previous messages along
with who sent them and when. If you click “ask” the text “May I tune the remote?” will be sent.
This chat is also useful for coordinating usage among operators as well as asking advice
about how something might be done.
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Double-click on the line with the UARC remote: This should cause a connection to the
remote. When you connect to it, a screen will appear saying that it is “Starting Up” and if all
goes well, you will see a graphical depiction of a generic radio that looks something like this:

Figure 3:
This is representation of the radio’s interface that you will see after connecting to a remote site.

There are a few features of this screen that you should observe:
•

Audio bar. Along the top, just above the frequency display you will see a bar with a
representation of audio waveforms just to the left of the “Vol” slider. This bar slides to
the left and provides a graphical representation of the recent audio, the newest at the
far right.

•

Vol control slider. To the right of the audio bar is a small slider: This is how the receive
audio is adjusted.

•

Mic control slider. Just to the right of the Vol slider is the adjustment for the
microphone gain – more on this later. This setting is not remember unless you
“save” it – see Figure 4.

•

Frequency display. In yellow, above the virtual tuning knob is a display showing the
current frequencies.
◦ The upper frequency is that of VFO A. In the lower left corner of the yellow display
area you can see that the “VFO A” box is darker, indicating that VFO A is currently
that to which the radio is tuned.
◦ The lower frequency in slightly smaller numbers is that of VFO B. Next to the
darker-gray VFO A box in the lower left corner of the yellow screen you can see that
the “VFO B” portion is not darker, meaning that VFO B is not selected.
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Checking receive audio:
At this point you should be seeing audio on the moving Audio bar at the top of the screen
scrolling to the left and you may hear what is being received on your computer’s speaker. (If
the bar is a straight line and you hear nothing, read the sidebar “My speaker works but I see
nothing on the audio bar”.)
If you don’t hear the audio – but you see the audio bar
indicating audio signals as can be seen at the top of Figure 3,
check the following:
•
•
•

•

Is the remote radio “powered” down? If it doesn’t
seem to respond to tuning, press the PWR button on
Figure 4:
the top row in the panel to the right of the main display.
Vol slider. Try moving the Volume slider to the right – it
What you will see if the radio
may have been turned all of the way down.
has been remotely “powered
Are your computer’s speakers enabled?
off”
◦ If they are external, powered speakers, make sure
that they are turned on and connected.
◦ Make sure that you haven’t muted the speakers on your computer or turned the
computer’s volume control all of
the way down. To check this,
play some music or a video on
your computer and verify that the
audio is working and fix any
problems that
you may be
having.
Are you are using headphones or
a remote Bluetooth speaker? If
so, make sure that these are
connected/turned on, using music or
video to troubleshoot.

If you have verified that you can get audio
from your computer by playing music or
video, here are a few more things to check:
•

•

Figure 5:
In the upper-left corner of the
RCForb screen just under “File” is a
The dialog box for configuring/testing audio in/out settings.
drop-down tab labeled “SPKR”
Click on this and make sure that Important: Once you have determined the best settings for
your speakers are properly selected. Vol (receive) and Mic (transmit) audio levels, click on the
Save button. Unless you use the Save feature, the
program will not remember your settings when you restart
the program.

Note:
On
some
computers/Windows configurations
this drop-down tab may not work correctly, making difficult/impossible to select the
audio source. If this is the case:
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•

In the upper left-hand corner to the right of File is the Options tab: Click this and
select Audio Device Settings. The resulting dialog box is represented in Figure 5.

•

Clicking on the Test Speakers button should produce a very brief noise. If it does, the
RCForb client’s audio is set up
correctly
and
we’ll
check
“My speaker works, but I see nothing on the
something else shortly.
audio bar!”
If clicking on the Test Speakers
button doesn’t make a noise, The audio bar at the top of the RCForb screen indicates
click on the Speakers bar to that the server is getting audio from the radio: If you see
display a drop-down bar and something other than a straight line – usually a bar of
select the proper speaker. Note: varying width according to amplitude – then the server is
getting audio from the radio: If you can’t hear this audio,
It would be unusual for the re-check your configuration as described.
“default” setting to not work “out
of the box”. One reason why it If the line is flat then there is no audio from the radio.
may not work is if you have While it’s possible that something is wrong with the radio, it
more than one sound card and is more likely that someone else changed the radio’s
configuration such that there is no audio.
the default card is not connected
to the speaker/headphone. If In that case, check the settings of the following sliding
you have more than one sound controls located below the frequency display. Note that
card you may need to try several you may have to use the “slider bar” to move the selection
up and down to see them all.
selections.

•

If you can’t get audio from the RCForb
program and you see audio moving
across the top of the screen and you
have verified that you can play
music/sound on your computer and
hear it you’ll need to do a bit more
digging around and, possibly, enlist the
help of your local computer nerd or a
UARC officer.

Tuning the radio:

•
•
•

RF Gain: Set to “100%”. If set to “0”, the receiver
is effectively disabled.
SQL (squelch): Set to 0 to disable. If not zero, the
squelch may be muting the audio.
Verify that you aren’t in transmit mode (e.g. the
“TX” button is yellow). If it is in transmit mode,
click on the “TX” on the virtual radio to switch it off
or click on the “RX” button – next to the “VOX”
button - in the extreme upper-right portion of the
RCForb display to set it back to receive.

If you are still having no luck hearing audio, contact the HF
station manager.

Once you are able to hear audio from the receiver you can tune around. There are at least
three ways to tune the radio.
•

Using the mouse, “over” over a digit on the virtual radio’s frequency display and
use the mouse wheel.
◦ This is probably the easiest way to tune the radio.

•

On each frequency display are up and down arrows above/below each of the digits.
One can use the mouse to click on each digit to change it: The frequency will change
immediately.
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◦ Note: The smaller (lower) display is that of VFO B and changing its frequency will
cause the radio to switch to VFO B. When a VFO’s frequency is changed, the radio
will switch to using that VFO as indicated by the “VFO A” or “VFO B” indicator on
the main frequency display changing.
•

Direct frequency entry. Just below the upper-left corner there is a virtual numeric
keypad with blank line just below the label “Number Pad”. Clicking on the empty line,
you can enter the frequency one of two ways:
◦ Type the frequency into the box using your computer keyboard. The frequency is,
by default, in kHz but the “Frequency Format” box allows one to select between
Hz, kHz and MHz as desired.
◦ Use the “virtual keypad” just below the box to enter the frequency by clicking on the
numbers.
◦ Once you have typed the frequency, hit Enter and the radio will tune to that
frequency.
▪ Note: On some screens/displays this keypad may not render properly and not
all buttons of the virtual keyboard may be visible, but you will still be able to
enter numbers and the decimal point with your keyboard. This is an issue with
the program and not your computer.
◦ Just below the blank line where the frequency being entered is displayed are three
buttons: “A”, “B” and “Both”. Selecting A or B will change the frequency of VFO A
or B, respectively while selecting Both will cause the same frequency to be entered
in both VFO A and VFO B.
◦ When a frequency is changed, the radio will switch to using the VFO that you just
changed as indicated by the “VFO A” or “VFO B” indicator on the main frequency
display changing.

•

Using the virtual tuning knob(s). On the virtual radio display there are two large
tuning knobs and the frequency can be changed by hovering the mouse over the knob
and then holding the left mouse button down while “dragging” the knob to turn it:
◦ The largest knob just below the display next to the small letter “A” is for VFO A.
◦ The smaller knob to its right next to the small letter “B” is for VFO B.
◦ Again, when a VFO’s frequency is changed, the radio will switch to using that VFO
as indicated by the “VFO A” or “VFO B” indicator on the main frequency display
changing.
◦ Adjusting tuning step size of the virtual knobs:
▪ If you use the virtual tuning knobs you may wish to set the step size. To the
right of the smaller tuning knob (the one for VFO B) are two pull-down menus. In
these menus are the step sizes in kHz, ranging from 0.05 kHz (50 Hz) to 1000
kHz (1 MHz).
◦ For casual tuning on SSB even a 50 Hz step is a bit large and this limits the
usefulness of the tuning knobs. If you wish to precisely tune in some stations, use
the “up/down” buttons/mouse wheel on the display to tune the exact frequency of
the other station.
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Section 5: Other radio controls
For those familiar with the controls found on modern radios, the following section will be
useful in knowing the “how to do what” and “what works and what doesn’t”. If you are not
familiar with controls found on HF rigs the descriptions may help, but you may still wish to ask
someone if you are still unsure about what they do and how they may be used.

Mode selection:
In the upper-left corner of the virtual radio display is the drop-down mode selector. On this
remote system, only the following modes are supported:
•
•
•
•

•

LSB – Lower sideband. This is used for voice communications on all amateur bands
below 10 MHz (e.g. 160, 80 and 40) with the exception of the 60 meter channels.
USB – Upper sideband. This is used for voice communications on all amateur bands
above 10 MHz (e.g. 20, 17, 15, 12 and 10 meters) and on the channelized 60 meter
band.
AM - This is rarely used on any amateur bands with the exception of a few AM nets
where many of the participants use vintage gear. Please refrain from using this mode
without first consulting a UARC officer.
CW - This is used for Morse communications and is legal on all HF bands. On this
Icom radio, an “LSB” offset is used on the lower bands (below 10 MHz) and a “USB”
offset is used on the higher bands. The CW-R mode is available and is opposite this
convention. See section 7 for more information about CW operation.
FSK – Originally intended for frequency-shift keyed modes RTTY (Radio Teletype) this
is “mode” is the same as SSB except that the passband is shifted higher in audio
frequency, cutting off the lows. Like the CW mode, this uses LSB for frequencies below
10 MHz and USB for those above, except for the FSK-R mode which, like CW-R, is
opposite.
◦ Do not use the FSK mode unless/until cleared by a UARC officer.

Antenna:
The TS-480 has two antenna ports. These antenna(s) are described below.
•

•

Antenna ONE: This is a “G5RV” antenna capable of being tuned on most bands from
80 through 10 meters with the possible exception of the 60, 30, 17 and 12 meter
bands. Whether or not the radio’s built-in antenna tuner can match to a particular band
may depend on the frequency of operation within that band.
Antenna TWO: This antenna is an end-fed half-wave antenna that has been designed
to operate on 160 (from approximately 1800 through 1900 kHz), 80/75 meters (the
upper half), the 60 meter frequencies and 40 meters. This antenna may “work” on
other bands, but expect the G5RV antenna to have better performance – particularly
on the higher bands.
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Note that the radio “remembers” the antenna selection on a per band basis: For
example, if the previous user had antenna Two selected for 80 and 40 meters but antenna
One selected for 20 meters, it will keep this setting.

Auto Tune:
This selects the behavior of the radio’s built-in antenna tuner:
•

•
•

Both RX/TX. In this mode the antenna tuner will automatically tune the antenna as
you change the frequency/band while receiving.
◦ Note: This radio “learns” when transmitting the matching of the antenna to the
particular frequency and it uses this information when tuning on receive. If the
radio has never transmitted on this frequency, it will not automatically tune because
it has no information on how to do so.
TX Only. While receiving, the radio’s built-in antenna tuner is bypassed, being
switched in when transmitting.
Off. The built-in antenna tuner is always bypassed.

Normal setting: “Both RX/TX”

Important:
The antenna tuner will “remember” the internal settings from the last time it was
tuned to a specific band, frequency and also the antenna that was selected.
Examples:
•
•

•

You have tuned to 3700 kHz using antenna One and press the “Tune” button.
Next time you tune to 3700 kHz, the radio will remember the internal settings of
built-in antenna tuner and will not have to find the match again.
If you are tuned to 3700 kHz and switch to antenna Two and you press the
“Tune” button. It will also remember the tuner’s internal settings – but these
may be different from antenna One. In other words, the radio will “remember”
the antenna tuner settings on a per-band and per-antenna basis.
On some bands – such as 160 and 80/75 meters – the antenna tuner may need
to readjust as you go from one end to the other. The radio is capable of
remembering the tuning settings of different frequencies across the band.

AGC:
This adjusts the “decay” and mode of the receiver’s AGC (Automatic Gain Control).
•

Off. This disables the AGC. Do NOT use this mode unless you know exactly how
to “ride” the RF gain control at the same time.
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•
•

Slow. When a strong signal goes away, the radio’s AGC causes the RF gain to slowly
drop back down to tracking the background noise level. This is the mode typically
used for SSB and CW operation.
Fast. When a strong signal goes away, the radio’s AGC causes the RF gain to
“quickly” fall back to the background noise level. This is sometimes used for CW
operation, but it can make SSB reception sound “harsh” and noisy.

Normal setting: “Slow”

TX Meter:
This allows the selection of what will be displayed while transmitting on the main display.
Always set this to “SWR” when you tune the antenna tuner and watch for any brieflydisplayed messages that show “High SWR” indicating that the currently-selected
antenna-frequency combination cannot be tuned.
•

•

Power. This will show the transmitted power. Because of the nature of SSB, it may
not easily show the peak transmitted power, but it should be deflecting significantly on
voice peaks while transmitting on sideband. For CW, the key-down reading should
show the output power.
SWR. This shows the SWR at the current frequency. With the built-in antenna tuner,
this should be below 1.5:1, but if it is not, check the following:
◦ The radio may have not operated before with this antenna/frequency combination
and the tuner settings may not be in its memory. Click on the “Tune” button (topright on the control panel) to cause the radio to tune to the current frequency.
▪ If the radio can’t tune on this antenna/frequency combination, an error may
show up and/or you will still get a high SWR reading.

•

Comp. This shows the level of audio compression while transmitting on SSB. For
best results – particularly on a noisy band – the speech processor should be enabled,
as in:
◦ On sliding menu below the display: Both “Proc In” and “Proc Out” set to mid-scale
(approximately 50).
◦ When you are talking, meter on the frequency display should show about mid-scale
on voice peaks. If it does not, check the following:
▪ Mic Gain (on the sliding menu below the frequency display) should be roughly
mid-scale at around 50.
▪ On YOUR COMPUTER, look at the top of the RCForb’s window, above the
upper-right corner of the main frequency display and look for the “Vol” and “Mic”
settings. As you talk, with the microphone quite near your mouth, adjust the Mic
setting upwards/downwards to set the the microphone gain on your computer.
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•

•

If you set the microphone gain too high the sliding waveform display to the
left of the Vol slider will turn RED indicating that your audio level is too high,
causing distortion which will result it your voice sounding terrible on the air.

ALC. This shows how “hard” the RF amplifier is being driven. When you talk, this
should deflect the meter about 1/3 scale on voice peaks.
◦ If it does not deflect: Your audio level is too low and you are not transmitting with
much power. If this is happening:
▪ Readjust your Mic gain – see the setting about “Comp”, above to make sure
that the radio’s Mic Gain setting and the programs Mic setting (which adjust the
microphone gain on your computer are set correctly.)
◦ If it regularly deflects much more than 1/3 scale: Your audio level is too high
and will likely sound harsh or distorted on the air. Again, refer to the information in
the “Comp” setting, above.

Normal setting: ALC or Power, depending on your preference – but you should check both
when you are setting up.

Tx EQ:
This sets different audio equalization for transmitted audio and can help compensate for
deficiencies/quirks in the microphone in your phone and/or on your computer.
You should leave this in the “Off” setting unless/until you know, from on-the-air
testing, the effects that the various settings have on your audio.
DO NOT try to adjust this setting while listening to yourself live on another
receiver or WebSDR system. You will not be able to properly judge your own
voice qualities while listening “live” on the air.
Always ask others on the air to judge the settings.
•
•
•
•
•
•
•
•

Off. There is no transmit audio equalization. Unless/until you do on-air
experimentations of the setting with other amateurs, leave this in the OFF
position.
H Boost1. This setting is one permutation in which the high frequency audio
components are boosted.
H Boost2. This setting is one permutation in which the high frequency audio
components are boosted, different from setting 1.
F Pass. Yet another filter setting, affecting transmit audio.
B Boost1. This boost the bass (low frequency audio) on transmit audio.
B Boost2. This boost the bass (low frequency audio) on transmit audio, but is different
from #1.
Conv. An audio equalization that is intended to be optimized for voice conversations.
User. This is a user-defined audio equalization setting. Refer to the Kenwood TS-480
manual for more information on this setting.
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Normal setting: Off, unless you know a particular setting is appropriate for your microphone/
voice.

Rx EQ:
This sets different audio equalization for receive audio and can help compensate for
deficiencies/quirks in the speaker of in your phone and/or on your computer. Feel free to
experiment with the various settings to see which one sounds best to your ears.
This has no effect on transmitted audio.
•
•
•
•
•
•
•
•

Off. There is no receive audio equalization.
H Boost1. This setting is one permutation in which the high frequency audio
components are boosted.
H Boost2. This setting is one permutation in which the high frequency audio
components are boosted, different from setting 1.
F Pass. Yet another filter setting, affecting received audio.
B Boost1. This boost the bass (low frequency audio) on received audio.
B Boost2. This boost the bass (low frequency audio) on received audio, but is
different from #1.
Conv. An audio equalization that is intended to be optimized for voice conversations.
User. This is a user-defined audio equalization setting. Refer to the Kenwood TS-480
manual for more information on this setting.

Normal setting: Off.

“Slider” adjustments below the main frequency display:
These adjustments are in a menu below the main frequency display and consists of sliders
that can be moved left/right to set their value. Because there are more settings than are
visible at once on the screen, there is a “slider bar” on the right side of this display that allows
more settings to be revealed by clicking-and-holding the left mouse button on this slider while
moving it up and down.

CW Filter Width:
When in CW mode this adjusts the receive bandwidth. It has no effect in SSB mode.
At this time, the frequency display in the box to the left of the slider may show
nonsensical values.
Note: This control interacts with “FC Shift” - see below for notes and warnings.
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Normal setting: 1kHz – and experiment from there.

FC Shift:
This control (apparently) shifts the center frequency in both CW and SSB modes. This filter is
used together in CW mode with the “CW Filter Width” control (above).
Initial setting: 1.2-1.3 kHz, for SSB and CW – adjust to suit your taste.
Comment: The frequency display does not seem to properly match what is happening.

Mic Gain:
This does what it says: It sets the microphone gain of the transceiver. In the case of this
remote, this control is not particularly useful and it should always be left at 50%.
The reason for this is simple: Your microphone is not connected to the radio – but rather the
host computer at the remote site is, so this setting is adjusted not for your microphone, but
rather the audio level output of the computer and into the radio.
Do not adjust this setting: Instead, use the “Mic” control near the top-right corner of
the RCForb display. Remember to “save” the setting (see Figure 4) so that the
program “remembers” it when it starts up.
Please leave this setting at 50. If you happen to adjust it, please reset it to 50 when you are
done.

CW Speed:
This sets the speed in WPM.

RF Gain:
This control may be a bit difficult for one new at HF operation to understand, but it effectively
limits how sensitive the radio can be by setting the bottom limit of the AGC, the status of
which is indicated by the S-meter.
A value of “100%” on this radio means “maximum sensitivity” because the S-meter will be
allowed to go all the way down to “S-0” where the radio’s AGC is at maximum and the
weakest signals may be audible. By setting this control at a lower number, the minimum Smeter reading will be higher. For example, setting the RF gain control at 47% will prevent the
S-meter from reading below approximately “10 over S-9” which means that signals weaker
than this may be difficult to hear, but signals strong that this will be unaffected.
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Why use this? If you are on a round-table conversation or listening to a net and most stations
are quite strong you might wish to set the RF gain control down a bit so that the S-meter
never gets down as low as the background noise. By doing this, the receiver is quieter when
no-one is talking rather than “gaining up” to the point of hearing the background noise and the
static crashes.
When in doubt, leave the RF Gain control at 100%.
If, when you connect to the remote station and you hear nothing or many signals are very
quiet/weak, check to see if the previous user forgot to reset the RF gain back to 100% and
also that the squelch (see below) is set to 0.

RF Power:
This allows the setting of the maximum transmit power, in percent, from 0 through 100.
Because the maximum power of the transceiver is 100 watts, this setting correlates roughly
with the peak power in watts of the transmitter in SSB and CW modes.
For SSB operation the setting is typically 100% (100 watts).

Squelch:
This is the squelch setting and it should normally be left at 0.
The usefulness of a squelch on HF is debatable and is not usually very useful owing to the
fundamental difference in the way FM and SSB work. On FM it is the “quieting” of the receive
signal that sets the squelch and how strong it is has little to do with it directly. On SSB,
measuring this “quieting” is not possible: Unlike an FM signal that stays at constant power as
long the mic is keyed, RF output on SSB goes to zero during periods of silence.
On SSB, the squelch is based solely on signal strength, but because SSB signals vary in
their output power and signal levels on HF vary wildly – and static crashes are frequent,
particularly in the summer – a squelch on HF isn’t usually very helpful.
If you adjust the squelch, please reset it to 0 when you are done.
If, when you connect to the radio and don’t hear anything, make sure that the squelch is set to
0 and that the RF gain is set to 100.

Proc In:
This adjusts the aggressiveness of the speech compressor:
A typical setting for these controls is in the range of 25-30.
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Monitor Level:
This control should be set at zero: It will likely be removed.

NR Level:
This control adjusts the aggressiveness of the DSP noise reduction which is active as set by
buttons DNL1, DNL2 or DNL3.
A setting of 0 has less effect while a setting of 9 is so strong that it will adversely affect
intelligibility in many cases. Adjust this setting to suit your taste under the prevailing band
conditions.
Noise reduction should never be used when trying to receive any digital mode as it will
“corrupt” the audio and make reception impossible.

Buttons to the right of the main frequency display:
TX:
Pressing this button (and making it turn orange) will cause the radio to enter transmit mode.
In sideband, the receiver will be muted but no RF power will be produced unless there is
transmit audio.
In AM, the receiver will be muted and the radio will produce a resting carrier at about 30% of
the power set by the “RF Power” control which is modulated to 100% of that power by
transmit audio.
In CW mode the receiver will be muted and the transmitter will do nothing. In other words,
one cannot use the CW mode and the TX button to generate a CW carrier for triggering the
antenna tuner.

PWR:
This is a “soft” power button that will turn the radio on/off. If you see “PWR Off (see Figure 4)
click on this button to turn the radio back on.

Tune:
Clicking this button will cause the radio’s antenna tuner to find a match for the current
frequency and antenna selection.
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Important:
•

The TS-480’s built-in antenna tuner CANNOT be enabled on 160 meters.

•

Always set the “TX Meter” control to “SWR” when you tune the antenna tuner
and watch for any briefly-displayed messages that show “High SWR” indicating
that the currently-selected antenna-frequency combination cannot be tuned.

Note: For this to work, the Auto Tune selection must be either “Both RX and TX” or “TX
Only”.

A/B:
This swaps the frequencies/modes in the “A” and “B” VFOs.

A=B:
This copies the frequency/mode of the “A” VFO into the “B” VFO.

ATT:
This inserts a 20dB attenuator in receive when enabled. This is normally turned off.

Pre:
This enables an RF preamplifier when on. The only bands where this may help would be
10 and 6 meters.
This is normally turned off.

BC1:
This enables “Beat Cancel” mode 1 when turned on which automatically removes CW carriers
and heterodynes. Only BC1 or BC2 can be enabled at a given time.

BC2:
This enables “Beat Cancel” mode 2 when turned on which automatically removes CW carriers
and heterodynes. Only BC1 or BC2 can be enabled at a given time.
Modes 1 and 2 are similar in operation, but one would try both in a particular situation to see
which has the desired effect.
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DNL1:
This enables mode 1 of “Digital Noise Limiting”. Only one of the “DNL” buttons can be on
at a given time. Each of the three digital noise limiting modes operates differently: Try each
one in a given situation to see which works best.

DNL2:
This enables mode 2 of “Digital Noise Limiting”. Only one of the “DNL” buttons can be on
at a given time.
Each of the three digital noise limiting modes operates differently: Try
each one in a given situation to see which works best.

DNL3:
This enables mode 2 of “Digital Noise Limiting”. Only one of the “DNL” buttons can be on
at a given time.
Each of the three digital noise limiting modes operates differently: Try
each one in a given situation to see which works best.

NB:
This enables the noise blanker, which can be effective for certain types of static and “popping”
noises from power line interference.

NR1:
This enables mode 1 of the digital noise reduction, the strength of which is adjusted using the
NR slider. Only NR1 or NR2 can be enabled at a given time.
Try both modes and different settings of the NR slider to see which works best for a particular
situation.

NR2:
This enables mode 2 of the digital noise reduction, the strength of which is adjusted using the
NR slider. Only NR1 or NR2 can be enabled at a given time.
Try both modes and different settings of the NR slider to see which works best for a particular
situation.

Split:
This enables “Split” mode in which the “main” VFO (which could be A or B depending on the
“A/B” button) is used for transmitting and the “other” is used for receiving.

Page 21

Utah Amateur Radio Club

www.utaharc.org

Page 21

DO NOT OPERATE IN SPLIT MODE UNLESS YOU KNOW EXACTLY WHAT YOU ARE
DOING!
Operating with SPLIT mode on can result in your accidentally transmitting over the top of
another QSO, or even in a section of a band where SSB is not allow.
Make sure that this is turned OFF unless you are using SPLIT mode, and please turn it
off again when you are done.

*************
The following buttons appear only when your mouse is hovering over the
upper buttons.
*************
VOX:
This enables voice-activated keying. It also enables the transmitter for CW keying.
This is NOT useful for remote-control SSB operation.
Important:
For CW operation, the VOX MUST activated: If you don’t do this, the radio may
seem to go into transmit mode, but it will not transmit.

Proc:
This button enables the audio speech compressor (when the button is yellow) which can
greatly reduce the peak-to-average ratio of the RF transmit power, adding more “punch” to the
transmitted audio.
For casual operation, it is recommended that this be turned on as it can make a significant
difference in intelligibility. For “armchair copy” (e.g. very strong) signals or in some
roundtables others may request that you turn it off.
The compressor can help maximize the transmit effectiveness if the user’s microphone gain is
too low, but if the microphone gain is too high it is likely that it will cause background noise
and echos in the user’s local environment to be picked up and be very annoying to those
listening and in extreme cases, it can cause your transmitted audio to sound very bad!
The “strength” of the speech processing may be adjusted using the Proc In slider: A setting
around 30 is an appropriate starting point..
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Section 6: Setting up for and operating using SSB
Initial settings for SSB:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Mode: For voice, USB for 20 meters and higher, LSB for 40 meters and lower, USB on
60 meters.
Pre Amp: Off
Atten: Off – not selected (not yellow)
Pre: Off – not selected (not yellow)
Power: Normally 100W
RF Gain: 100%
Mic Gain: 50%
FC Shift: 1.2-1.3 kHz
SQL (squelch): 0
NR Level: Normally 0
NR button: Off – not selected (not yellow)
ANF button: Off – not selected (not yellow)
Proc (speech processor): On - selected (yellow)
Split: Off – not selected (not yellow)
Tx EQ: Off
AGC: Slow
VOX: Off – not selected (not yellow). This doesn’t work for remote operation, anyway.
Auto Tune: Both RX and TX
Antenna: One (Unless antenna “Two” exists and is connected)

Important: It may be necessary to transmit a carrier to allow the automatic antenna tuner to
do its job. See the section “tuning the antenna”.
SSB Transmit Troubleshooting
•

Not transmitting? (No power, cannot be heard)
◦ Check Mode (LSB/USB according to freq.) - it should NOT be CW
◦ RF Power slider should be higher than zero
◦ Check Mic Gain on radio slider: Set to approx. 50%
◦ Check “Mic” at top of program window – increase gain if oscilloscope line is flat. If
it is still flat after increasing the VOL slider, check your computer’s mic
gain/connection. Remember: Once you find the proper Mic setting, you must go
into the audio menu and save it (see Figure 4) or else it will be reset to default
every time you start the program.
◦ Check MIC setting in program (top, far left with drop-down selection) to verify
correct audio source
◦ Did you transmit for more than 180 seconds/3 minutes at once and trigger
transmit time-out? Switch back to receive and then try not to be so long-winded
next time!
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◦ If you are using RCForb Ver 0.9, MIC audio may not work on some computers – try
Ver. 0.8, instead.
◦ Is the band that you are on dead?
◦ Try tuning yourself in on a WebSDR to see if you are getting out (http://websdr.org).
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Section 7: Setting up for and operating CW
Initial settings for CW operation:
•

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Mode: CW or CW-R
◦ In Icom convention the dial frequency is that of received signal and not of that of
the “zero beat” frequency.
◦ On Icom transmitters, the receiver offset on CW is LSB for frequencies below 10
MHz and USB for frequencies above 10 MHz. CW-R mode reverses this
convention.
VOX: On – selected (yellow). Transmitter will not output power unless the VOX is
turned on.
Pre Amp: Off
Power: Normally 100%
RF Gain: 100%
SQL (squelch): 0
FC Shift: 1.2-1.3 kHz as a starting point.
CW Filter Width: 0.8-1.2 kHz as a starting point.
NR button: Not selected (not yellow)
BC1 and BC2 buttons: Not selected (not yellow) – Important – do not activate these
when using CW.
Pre Amp: Off
Atten: Not selected (not yellow)
Pre: Not selected (not yellow)
Power: Normally 100W
RF Gain: 100%
SQL (squelch): 0
NR Level: Normally 0
AGC: Slow
Auto Tune: Both RX and TX
Antenna: One (Unless antenna “Two” exists and is connected)
CW Filter Width: Adjust for your preference.

CW operation using direct keyboard entry:
•
•
•

Select the desired CW mode (e.g. CW, CW-R)
Click on the CW tab at the extreme bottom-left of the program window and type the
text you wish to send where it says “Type a message”.
Use the CW Speed slider for sending speed.
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CW operation using a local paddle:
It is possible to use a paddle connected to your computer rather than relying on the “text to
Morse” input. Doing this requires that your local computer has a working serial port (a USBto-serial interface is fine).
The paddle configuration may be found in the Options→Control Devices Setup menu under
the External CW tab. In this one may select the serial port being used and the pins used for
DIT and DAH.
Note: The external keying interface in RCForb 0.8x is rather primitive, lacking buffering and
Iambic operation. It is reported that the CW interface for attached keys and paddles in
RCForb 0.9x is improved over that in 0.8x.
“External” CW filtering:
Please note that the TS-480 has a “CW Filter Width” mode that may be used to customize the
receive bandwidth along with the “FC Shift” slider to set the passband center.
While it is far preferable to use the radio’s band-pass filtering to maximize signal dynamics, an
external audio filter may be used at the computer of the remote station user. In addition to
using a standard CW audio filter connected to the computer’s audio output (e.g. a device
made by MFJ, Ten-Tec or others) it is possible to route the receive audio through a computer
program that does filtering.
One such program is “Spectran” - a general-purpose audio analysis and waterfall display
program that also includes the ability to set arbitrary band-pass and band-reject filters. The
operation of this program is beyond the scope of this document, but general operation of this
program as a means of filtering audio is discussed on the page “Using your computer to
ambush unsuspecting NDBs”.
The difficulty with using a program on the same computer to provide filtering is that of routing
the audio from the speaker output back into the computer. While this could be done with a
second sound card (possibly running on another computer) and some audio cables
connected to it, a program like “Virtual Audio Cable” could be used to make virtual sound
cards.
As an example, RCForb could be configured using Virtual Audio Cable to send its audio
output to “Virtual Cable 1” and the Spectran program could then be configured to use “Virtual
Cable 1” as its input and then output the filtered audio to the speaker. The downside to this is
that the Virtual Audio Cable program currently costs $35: There may be “free” programs out
there that do similar things, but the author cannot vouch for their usefulness or “safety”.
With the RCForb audio routed to Spectran, audio filters may be set up – plus its native
waterfall display will show signals across the audio spectrum from the remote receiver.
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Another programs with similar features is DL4YHF’s “Spectrum Lab”. This program is
powerful and feature-laden and it is somewhat complicated: Please refer to online resources
for advice on how to use it.
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Section 8: Operating digital modes
At present, the transmission of digital modes via the HF remote is not permitted.
In theory, it is possible to operate digital or other “sound card” modes (FT-8, RTTY,
SSTV,PSK-31, etc.) via the remote, but there are a few things that need to be considered,
including:
•

Internet delay/dropouts. While it is possible to send audio over the Internet that
contains the modulation, one must consider that audio sent via the Internet has
variable delays and occasional drop outs. Some modes (FT-8, WSPR, etc.) require
nearly perfect timing and conveying the audio from a remote location via the Internet
may result in “uncopyable” transmissions on transmit and/or receive.

•

High transmit duty cycle. Most digital modes transmit a constant amount of power
for a significant duration so it is recommended that reduced power (a few 10s of watts
at most) be used to avoid thermal stress on the transmitter. With the radio being used
at this time this presents a problem as there is no easy way to monitor the transmit
power.

•

Routing of the user’s program/s audio to/from the remote. By default, the RCForb
program uses the computer’s speaker and microphone connections for receive and
transmit audio.
◦ Programs used for digital modes must have direct connections (via cables or some
“virtual” sound card routing) to the receive and transmit audio.
◦ When transmitting digital modes one must not use acoustical coupling. In other
words, you may not place the radio’s microphone near the speaker. Attempts to do
this not only result in poor-quality transmission, but spurious signals like audio
harmonics, background noises and “computer” sounds (dings, bells, notifications)
are likely to be transmitted as well.
◦ The use of a remote station complicates matters as there is no physical cable
connecting the radio. A work-around is to use a “virtual” sound card as afforded by
programs like “Virtual Audio Cable” ($35.00 at the time of writing) to allow internal
routing of audio paths. This is briefly mentioned in Section 7 of this document.
◦ Care must be taken to avoid routing the computer’s operating system audio to
prevent the accidental transmitting of things like system/email notifications, audio
from web sites and music that one might play on the computer.

For the reasons listed above, the transmission of digital modes
via the remote HF station is not permitted at this time.
We hope that we will be able to allow such operation someday, but this will require some
changes in the on-site hardware – and possibly a different HF transceiver. If you wish to
experiment with these modes in the meantime, please do so only with the permission of the
HF station manager and after appropriate testing has been done with your proposed set-up.
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Section 9: Activating the automatic antenna tuner
Important:
•

The TS-480’s built-in antenna tune cannot be activated on 160 meters.

•

Always set the “TX Meter” to “SWR” when you tune the antenna tuner and watch
for any briefly-displayed messages that show “High SWR” indicating that the
currently-selected antenna-frequency combination cannot be tuned.

The HF remote station uses a G5RV wire antenna for all bands and while this antenna has
“reasonably low” VSWR on most hf bands, it isn’t low enough to keep a solid-state
transceiver “happy”. Because of this, there is an automatic antenna tuner located at the
“radio end” of the feedline to present a 50 ohm match to the transceiver.
In reality, we are matching the “Feedline+Antenna” rather than the antenna and because of
the rather long length of the feedline, there may be some bands on which a match is
available, but the losses of the feedline reduce the radiated power from the antenna enough
to make operation difficult: Information on “known bad” band combinations will be made
available later.
In most cases, the antenna tuner will automatically detect the frequency of operation and if it
has “memorized” a match at or near that frequency, it will pre-set the tuner with the lastknown settings – but this doesn’t always work!
The TS-480 has a built-in antenna tuner which “remembers” its settings from the last time a
particularly frequency/antenna combination was used, but if you are tuning to a frequency
where the radio hasn’t yet been – or if there has been a change made to the antenna – you
will need to cause the antenna to tune.
When you setting up to transmit, it is recommended that for the first transmission that you
change the setting of the Tx Meter to “SWR” and observe the reading when you first transmit.
If the VSWR reads higher than 1.5:1, stop transmitting and press the Tune button. If all goes
well, the audio will be muted for a couple of seconds (at most) and the tuner will find a match.
If, for some reason the tuner does not find a match (you may see that error in the “faults”
window below the drop-down selections on the left side of the frequency display, or you may
not get a better SWR than before) then it is likely that one of the following has happened:
•
•

The Auto Tune setting was set to Off
The tuner could not find a match to this particular antenna/frequency combination. If
this happens, you will not be able to operate with this particular
frequency/antenna combination.
◦ If you know that this combination had worked in the past, re-check your antenna
and frequency selection. If you have verified that it is correct, contact a UARC
officer to let them know that there may be a problem.
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•

You may have inadvertently tried to transmit on a frequency outside an amateur band.
This radio/system will not allow this.

Important: While you may receive on 160 meters, the antenna tune and antenna will not
match on 160 meters, so please do not attempt it!
Note that it is usually possible to remotely “hear” one’s own transmission via a WebSDR site
(go to: http://websdr.org to find one in your general area) but note that the closest WebSDR
may be “too close” for ionospheric “skip” from the remote site, depending on frequency,
prevailing propagation conditions, time of day, etc. so you may have better luck using one
farther away.
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Section 10: Rules for operating the UARC HF remote
station
When using this remote station on any mode:
•

Before transmitting, verify that you are on a frequency that is appropriate for your
license class. You may not transmit on a frequency that is not consistent with
your license or license class, and you may not transmit until given permission to
do so by a UARC officer.

•

Always be courteous on the air:
◦ Do not tune up atop an ongoing conversation.
◦ You do not own a frequency, so please yield to nets that may routinely use a
particular frequency.

•

Users of the site will use their own call signs. However, we request that at the
beginning and at the end of your session you transmit “This is <your call sign>
using the UARC, W7SP club remote radio site.” Please do this only on a clear
frequency that is commensurate with your license class.

•

We ask that users limit extended use of this unique resource. If possible, limit each
session to about an hour. If others want to use the site, there is a dialogue box on the
screen they can use to request use. We leave it up to you to use the site responsibly.
Remember that HAMs are courteous, please share!

•

If ANY anomalous event occurs while you are operating this radio you are to report the
details to the UARC President within 24 hours by email or telephone. If you are unable
to reach the President, contact another member of the UARC Board, names and
contact
information
is
available
on
the
UARC
web
page:
(https://user.xmission.com/~uarc/cluboff.html)
◦ The above includes an apparent malfunction or problem with the radio or an
accidental transmission on a frequency that is not covered by your amateur radio
license.
◦ All operation on this remote site is logged in great detail.

•

The grid square for the Leamington site is DM39, we request that only this 4 digit grid
square be used.
◦ While grid squares are commonly used on digital modes and on 10 meters, they
are not usually used on other HF bands.
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How to get access to this station:
If you wish to obtain access to this station, there are a few prerequisites:
•

You must be a member of the Utah Amateur Radio club in good standing or receive
“special dispensation” on a case-by-case basis by the UARC president.

•

If you wish to transmit from this station, you must have a current General Class or
higher amateur radio license. (You do not need a license or even the club’s
permission just to listen, but someone with permission to transmit can “take” the tuning
of the radio away from someone without.)

•

You must contact the president of the Utah Amateur Radio Club and request access to
the station.

•

You must read and agree with the “Guidelines for use of the UARC Remote HF
Radio Station” document.

•

If you have other questions, feel free to contact the HF station manager at:
hfmanager@utaharc.org
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Section 11: Frequently-asked questions (FAQ)
•

“How do I get access to this station?”
◦ Please read Section 10 of this document.

•

“How can I help make this station better?”
◦ If you are willing to donate time, equipment and/or money, we would be happy to
talk to you! Please contact the HF station manager via email (contact information
on page 1) if you wish to help.
◦ If you have a decent HF station that you might be interesting in making remotely
available to UARC members (when you aren’t using it, of course) we would like to
hear from you.

•

“Can more than one person use this station?”
◦ Yes – but there are limits.
▪ Many people can listen at once to the receiver, but remember that there is only
one receiver and only one person can have control of it and tune it at a time. In
other words, everyone will be listening to the same thing.
▪ It is possible for several people to be able to use the transmitter, but there are
several caveats:
• Because there is only one radio, transmitting can be done only on the
frequency and mode to which the radio is set.
• Only one person at a time can transmit: When someone else transmits, you
will be able to hear their audio over your speaker.
▪ Allowing multiple parties to transmit is useful for a net or round table where
several of the users on the remote may wish to check in or talk, one-at-a-time.
▪ If you only wish to receive there are many Internet-accessible receivers around
the world: Go to the websdr.org site for a list of remote receivers world-wide
that allow many users at the same time to tune their own “virtual” receiver
independently of each other.

•

“I can’t hear anything at all on the receiver, not even hiss – what’s wrong?”
◦ Make sure that you are connected to the receiver. If you can tune the dial, you
are probably connected.
◦ Make sure that your computer’s sound is working: Try playing music/video.
Make sure your computer’s audio isn’t muted, its volume isn’t all of the way down
and, if you are using external speakers, that they they are turned on.
◦ The “Vol” slider at the top of RCForb may be all of the way to the left: Try
turning it up.
◦ Check the “SQL” slider on the radio: Make sure that it is at zero to disable the
squelch.
◦ Check the “RF Gain” slider on the radio: Make sure that it is set to 100.
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•

“When I am talking radio people are telling me that I sound terrible/quiet/noisy –
what’s wrong?”
◦ Make sure that you do NOT use your computer’s internal microphone: These are
almost always terrible and tend to pick up noises from the room you are in, the
computer’s fan, its hard drive and echoes.
◦ If you are using the Android app, people have had good luck using the microphone
build into their smart phone as long as it is not being used as a “hands free” device:
The microphone should be very close to your mouth. Do not use “hand’s free”
mode.
◦ If you have multiple microphones – including a remote Bluetooth – it may be that
your computer/device isn’t using the microphone that you expect. For example, if
you are using your Android device in a vehicle, it might be the car’s microphone that
you are using rather than the phone’s – and this will likely pick up a lot of extra
noise.
▪ If you are using an Android device, the microphone that you are using may
unexpectedly change: This can happen if you receive a telephone call or use
another app while the RCForb application is running.
◦ When you are talking, pay attention to the moving audio bar at the top of the
RCForb’s display: The bar should be wider than a single black line while you are
talking – the wider, the more audio you have. If you run too much audio, the bar will
change color on excessive peaks: It’s OK for it to change color occasionally but if
it’s almost always red while you are talking you need to reduce the microphone gain
on your computer.
◦ The RCForb program DOES NOT “remember” the previous Mic setting (the slider
bar at the top of the screen) unless you go into the audio menu and save it. Once
you have found the proper Mic setting for your computer/microphone combination,
go to: Options->Audio Device Settings and click the Save button at the bottomright of the pop-up window. Doing this will cause the program to remember the Mic
setting. You will have to do this on every computer that you use with this program
– and the settings will be slightly different.

•

“What antenna is used for this remote?”
◦ At this time a G5RV in a sloping configuration (the top is at about 60 feet AGL) is
being used in conjunction with an automatic antenna tuner. This antenna generally
works on the 80/75, 60, 40, 30, 20, 17, 15, 12 and 10 meter bands – but it does not
work on 160 meters. There may be certain band/frequency combinations that won’t
tune properly of which we are not aware, in which case you just won’t get out when
transmitting. Other types of antennas are being considered for use at the remote
site.

•

“Is there a web camera of this remote that I can look at?”
◦ Yes, there is a camera that looks at the radio and the antenna tuner. Its access and
capabilities are very limited: Please contact the HF station manager for more
information.

•

“Can I use a digital mode like FT-8 on this remote?”
◦ Not at this time – please read Section 8 of this document to find out why.
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•

“Is there a waterfall display like I see on other sites?”
◦ Not at this time. We are investigating possible means of providing this, but in the
mean time you can use one of the many WebSDR sites. For a worldwide list and
map of WebSDR sites go to websdr.org.
◦ The end of Section 7 of this document mentions the use of the “Spectran” program
which could be used to provide a waterfall display of the signals within the audio
passband. Because only the audio passband is available remotely, this display
cannot show signals above and below where the receiver is tuned.

•

“I want to run CW – is there a narrow filter?”
◦ Yes: You may adjust both the “CW Width” and the “FC Tune” controls to find the
bandwidth/frequency combination best suit your taste.
◦ See Section 7 for a possible work-around using the “Spectran” (or similar) program.

•

“What are the ways I can send CW?”
◦ Please refer to Section 7 for more information, but in short:
▪ Use the “text-to-Morse” interface built into RCForb.
▪ Connect a paddle to your local computer via a serial port.
• Note: RCForb 0.9 has better CW support for paddles/local key than version
0.8.

•

“I’m transmitting, but I can’t seem to get out! What’s wrong?”
◦ This could be due to any number of things, including:
▪ You haven’t caused the antenna tuner to tune to your frequency – See section
9.
▪ You are trying to operate on a band that can’t be matched with the tuner. At
present, 160 meters can’t be tuned with antenna ONE, but antenna TWO will
probably work between 1800-1900. Similarly, antenna TWO should not be
expected to work very well on 30 meters and above.
▪ Your microphone isn’t working: If you don’t see movement on the “audio bar” at
the top of the screen when you talk you’ll need to troubleshoot your computer –
See section 2 for links to documents that provide troubleshooting information.
▪ You may be using RCForb 0.9: For some reason the “mic” audio just doesn’t
work on some computers – try RCForb 0.8, instead.
▪ Make sure that you have selected USB or LSB (as appropriate for the band) if
you are using SSB. If “CW” is selected, the radio will appear to transmit, but
nothing will actually happen.
▪ The band you are on may be dead: If you don’t hear other signals, there may
be no propagation to your location at that time of day on that band. Sometimes
solar flares will quash all HF communications for hours/days.
▪ In general:
• 160 meters – Nighttime – long distances are possible, “local” (within 250 mile
radius) during the day. Receive-only operation is possible with this
remote at this time.
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•
•
•
•
•
•
•
•
•

80 meters – Nighttime – long distances are possible, “local” (within 250 mile
radius) during the day
60 meters – Often open during the day, better at night.
40 meters – Open night or day. During the day, useful from about 250 to
1000 miles, much greater distances at night.
30 meters – (Digital/CW only) – Open at medium/long distances day/night.
20 meters – Usually better propagation during the day than at night,
particularly during low sunspot cycles.
17 meters – Mostly daytime – openings are somewhat rare during low
sunspot cycles.
15 meters – Mostly daytime – openings are somewhat rarer than on 17
meters during low sunspot cycles.
12 meters – Mostly daytime – openings are even rarer than on 15 meters
during low sunspot cycles.
10 meters – Openings are rare during low sunspot cycles but “Sporadic-E”
openings may occur any time of day or night – particularly in the spring.

•

“Is there a linear amplifier at the remote site that we can use?”
◦ No.

•

“The audio sounds all ‘warbly’ - as if I’m listening underwater: What’s wrong?”
◦ It’s possible that a previous user has turned on the DSP noise reduction (the “NR”
buttons) and set the level too high via the “NR Level” slider. Set the NR Level slider
to something lower than 15 or so and/or click the “NR” button to turn it off.
◦ If the “NR” isn’t on and you are listening to signals on a higher band (e.g. 20, 17,
15, 12, 10 meters) it is possible that the signals that you are hearing are being
affected by propagation. Signal from Europe which traverse the North Pole are
often affected this way – particularly if there has been recent solar activity.
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